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1.0 System Requirements: 

 

 Minimum: 

 

 Microsoft® Windows XP SP2 

 266 MHz CPU 

 256 MB Memory 

 10 GB Free drive space 

 640 X 480 Resolution Display Card 

 USB 1.0 

 

 

 Recommended: 

 

 Microsoft® Vista SP2 or better 

 Dual Core 2.0 MHz CPU 

 2GB Memory 

 10 GB Free drive space (160+ GB HD 7200prm) 

 1024 X 768 Resolution Display Card 

 USB 2.0 

 Mouse 

 Color Inkjet Printer 

 

*The latest version of the Panther Combined software is available at www.rockdataservices.com/support/  

** Call (403) 340-3311 for further assistance or email support@rockdataservices.com  
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2.0 Software Installation 
To install the Panther software,  browse to the install CD drive and double-click 

“ParallelSerialUSBCombined-Setup.exe” or go to our website at www.rockdataservices.com/support/ and 

scroll down to the Software section and click on the latest version of the “Panther Combined v#.#... item and 

select run.  The installation will start and proceed with the screen prompts below: 
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Software Installation continued 
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Software Installation continued 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Software installation is now complete and USB driver installation will begin. 
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3.0 USB Driver Installation    3.1 Windows Vista installation 
To install the driver follow the screen prompts below:   

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select “Install this driver software anyway” 
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USB Driver Installation continued  3.1 Windows Vista installation 

  

 

 

When the installation is complete attach the communication cable to a Panther tool and to a USB port on your 

computer.  You will receive a similar message to the ones below after the tool has been connected.  You are 

now ready to run the Panther USB Combined software in order to communicate to a Panther tool. 
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USB Driver Installation continued 3.2 Windows XP SP3 installation 
To install the driver follow the screen prompts below: 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select “Continue Anyway” 

www.rockdataservices.com Section 3.2 

http://WWW.rockdataservices.com


 

USB Driver Installation continued  Windows XP SP3 installation 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select “No, not this time” 
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USB Driver Installation continued  Windows XP SP3 installation 
Select “Install the software automatically (Recommended)” 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select “Continue Anyway” 
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USB Driver Installation continued  Windows XP SP3 installation 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When the installation is complete attach the communication cable to a Panther tool and to a USB port on your 

computer.  You will receive a message similar to the ones below after the tool has been connected.  You are 

now ready to run the Panther USB Combined software in order to communicate to a Panther tool. 
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4.0 Installation Troubleshooting: 
If you receive the following error during a Windows Vista installation: 

 

 

 

  

 

 

 

 

 

 

 

Ensure that the current user of Vista has Administrator rights.  You may also have to turn off the User Account 

Controls in Vista.  To do so open the Control Panel from the Start Menu.  Then select Users Accounts.  Then 

select “Turn User Account Control on or off”.  De-select the “Use User Account Control (UAC) to help protect your 

computer”.  Then Run the installation file again. 
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5.0 Well Information 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Completing the well information is not required if a report is not being prepared.  If a pressure survey report or gra-

dient report is being created the information should be entered. 

Enter the company name and remainder of the information.  The top and bottom recorder file names will appear 

after the gauges have been downloaded or may be browsed in if they were previously created.   

When complete choose File from the menu system then 

Save As.  The name which defaults is “Panther1”.  A more 

descriptive name appears below that was entered manu-

ally.  Choose the location the file is to be saved in by click-

ing in the Save in: box. 
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6.0 Download Tool 
To download a test from a tool: 

Connect the tool to the communication cable and the cable to a USB port on the computer. 

On the main Section of the software, click on the Download button for either the top or the bottom recorder, corre-

lating top and bottom with the gauges to be downloaded.  The Download Tool dialog box will be displayed. 

Select a test from the list of tests on the tool.  The tests will be in sequence, with the last test done at  the end of 

the list.  Each time the battery has been connected and disconnected creates a test. 

Battery On Time: Enter the battery on time. 

Multi-Selection: Downloads more than one test at a time.  Each test will be downloaded into its own file.  You will 

be prompted to provide an initial filename and each subsequent file will be appended with “-####” in the order 

they are downloaded. (i.e. the first test would be named S1825N-0001.-TOP.DTO, second test would be named 

S1825N-0002-TOP.DTO, and so on) 

Download as One:  All tests will be downloaded into the same file.  Use this option to combine multiple test files 

into one combined file.  Note: This option requires that the Multi-Selection option is checked.   

Download Selection: Downloads the selected test(s). 

Finished Download: Completes the download process. 

Cancel: Closes the Download Tool dialog box. 

 

Click on the Download Selection button to download the tool data.  A  submenu will appear showing the directory 

where your downloaded files will be saved to.   You will then be prompted to provide a filename for your test (i.e. 

gauge (example: 9475)).  The default file extension is .DT0.   If the well information is entered the filename will 

default to the first 3 characters of the company name and first 5 of the location (ie. ABC100-1-0001-TOP.dt0)  

Note:  The system will allocate the last directory or drive that a file was saved to.  Thus, if a gauge was downloaded 

and saved to, for example, your My Documents folder, the system will default to your My Documents folder.  Select 

Cancel and a submenu will appear listing the Desk Top, My Computer, etc.  Select My Computer to access the di-

rectory that you want to download and save the gauge data to. 

When the test is finished downloading, click on the Finished Download button to complete the download process. 

You should see the file name in the File Name text box of the Top/Bottom Recorder section on the main Section of 
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7.0 Program Tool 
ALL DATA WILL BE ERASED FROM THE TOOL WHEN REPROGRAMMED.  ENSURE ALL DATA IS DOWNLOADED 

BEFORE THE TOOL IS REPROGRAMMED. 

To program a tool, click on the Program Tool 

button on the main Section of the software. 

The Program Tool dialog box will be dis-

played. 

End (hrs): This is the end time for the current 

sample rate.  (i.e. 6 hrs) 

Sample Interval: This is the sample rate for 

the program to the End (hrs) time. 

Add: Inserts the End (hrs) and Sample Inter-

val into the Program List.  The Start (hrs) is 

automatically calculated based on the End 

(hrs) of the previous program item in the list.  

Each time you add an item to the program list 

the number of samples and samples left is 

recalculated and displayed under the pro-

gram list.  The samples can not be greater 

than the Max. Samples shown. 

Remove: Removes the selected program 

from the list of program entries. 

Clear List: Clears the list. 

Program Tool: Stores the list of programs on 

the tool. 

Read Tool: Reads the program information from the tool and displays it. 

Exit: Closes the Program Tool dialog box. 

Note: If you do not use all of the available samples, the remaining samples will be set to run at the Master 

Sample Interval of 30 seconds.  If your last Sample Interval was 30 seconds, the remaining available samples 

will be added and the End (hrs) will be recalculated. 

If a message appears stating ‘TOOL NOT FORMATTED’, exit out of this section and contact  Customer Sup-

port . 

For  Assistance Call (403) 340-3311    Section 7.0 

pant_CustomerSupport.htm
pant_CustomerSupport.htm


Program Tool Continued 
7.1 To program a 4MEG REV 3 tool with more than 1 sample per second 

To program a tool with fast samples, click on the Program Tool button on the main Section of the software. 

The Program Tool dialog box will be 

displayed. Some tools are capable of 

taking fast samples (more than 1 

sample per second).  If so, the dialog 

box to the left will be displayed.   You 

can then select 16, 8, 4 or 2 samples 

per second for a time duration or still 

choose to program the tool to  1 sam-

ple every n seconds.   You may pro-

gram the tool with fast and standard 

sample rates within the same pro-

gram. 

If you select Pump Tool option the 

tool with be programmed to the stan-

dard pump tool rate for the entire 

duration of the test. 

End (hrs): This is the end time for the 

current sample rate.  (i.e. 6 hrs) 

Sample Interval: This is the sample 

rate for the program to the End (hrs) 

time. 

Add: Inserts the End (hrs) and Sam-

ple Interval into the Program List.  

The Start (hrs) is automatically calcu-

lated based on the End (hrs) of the 

previous program item in the list.  

Each time you add an item to the program list the number of samples and samples left is recalculated and 

displayed under the program list.  The samples can not be greater than the Max. Samples shown. 

Remove: Removes the selected program from the list of program entries. 

Clear List: Clears the list. 

Program Tool: Stores the list of programs on the tool. 

Read Tool: Reads the program information from the tool and displays it. 

Exit: Closes the Program Tool dialog box. 

Note: If you do not use all of the available samples, the remaining samples will be set to run at the Master 

Sample Interval of 30 seconds.  If your last Sample Interval was 30 seconds, the remaining available samples 

will be added and the End (hrs) will be recalculated. 

ALL DATA WILL BE ERASED FROM THE TOOL WHEN REPROGRAMMED.  ENSURE ALL DATA IS DOWNLOADED 

BEFORE THE TOOL IS REPROGRAMMED. 

If a message appears stating ‘TOOL NOT FORMATTED’, exit out of this section and contact  Customer Sup-

port . 
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Program Tool Continued 

7.2 Single Channel Display Logger (only) 

If you are programming the single channel display logger it contains a real-time clock that will set the date & 

time of the unit being programmed to the system date & time from the computer programming it.  After the 

Program Tool button has been clicked a pop-up window will be displayed asking you to confirm the date & 

time from the computer.  If the date & time is incorrect then click Cancel in order to re-set the computer’s sys-

tem date & time from your operating systems Date & Time properties window.  To do this simply double-click 

on the time on your computer’s system menu bar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If the system date & time is correct then click OK.  The next step is to select the pressure units desired to dis-

play and click OK. 

 

 

 

 

 

 

 

 

 

 

 

The software will then program the tool.  The status of the programming may be viewed near the bottom left of 

the screen. 
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Program Tool Continued 

Typical Programs: 

We suggest starting programs with a 10 second sample rate. 

(An example of a typical program: 0 – 6 hours with a 10 second sample rate, defaulting to a 30 second sam-

ple rate on the 6th hour)  NOTE:  When a tool is reprogrammed, all prior data is erased from the tool. 

 

7.3 Saving Program Table to Disk: 

You can save your program table to disk by selecting File -> Save from the Program Table Menu Bar. 

The default save file name is Serial Number + yyyymmdd.txt. 

This saved file can be viewed and printed using Microsoft® Notepad or WordPad. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.4 Battery Life: 

Contact Rock Data Services for standard battery life or to obtain a chart with battery life expectancies. 
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To graph a test, click on the Graph button on the main Section of the software from either the top or bottom 

recorder. This will cause an option screen to appear which will allow you to plot one or both gauges data.  If 

a .DT file is not present you will be prompted for one. 

8.1 Setup Options 

 

If two .DT0 files are listed but you wish to plot only one gauge click “Clear File” to remove the gauge you do 

not wish to plot.  If only one .DT0 file is listed and you wish to plot two gauge’s data then click “Browse 

for .DT0 file” above the empty file listing.   

If the gauges were not started at the same time you may “Shift Bot.DT0 Samples” by a positive or negative 

amount in order to line up the two gauge’s data so that they pressure up and down at the same time. 

You may select the display units of the data by selecting them from the drop down menu for “Display 

Settings”.  If you are choosing to plot the data in Absolute units enter the imperial or metric value to 

convert the data from gauge units.  The Alberta average for atmospheric pressure is 93.01 kPa or 13.49 

psi. 

If the gauge(s) contain a large amount of data you may choose to filter the data to not plot every data point 

by entering or adjusting the “Sample Filter” amount. 

The “Display Data Grid” refers to a column listing of the gauge(s) data readings that can be displayed along 

side the plot.  If you do not wish to see this data or would like to decrease the amount of time it takes to 

generate the plot uncheck the box next to it. 

The “Combine Top/Bot .DT0 files on the same Graph” option will allow you to plot the top and bottom data 

recorder on the same plot or individual plots. 

The “Use Same Min/Max Scale” option plots the pressure and temperature data using common axis 

scales if they are on individual plots. 

The “Create Differential Graph” option will plot a pressure and temperature differential graph displaying 

the difference between the Bottom—Top gauge data.  This is useful in determining if the gauges are 

reading similarly and properly. 
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www.rockdataservices.com Section 8.1 continued 

Click “Graph” to see the plot(s) with your desired items selected.  A new window will appear.  A legend of 

the data items and their corresponding colors is displayed near the bottom of the window.  If the data 

grid is displayed on the right hand side but you do not see all of the data column items you may scroll 

left or right with the scroll bar at the bottom of the data grid.  You may also maximize the window size by 

clicking the square button on the top right of the window which may display more columns.   

8.2 Mouse Tips 

If you hold the mouse pointer over a point and data series on the 

graph a pop up window will appear displaying the value of the data 

point the mouse is over. 

You may also hold the mouse over an item in the data grid in order for 

that data point to be highlighted on the plot. 

 

If you hold the mouse 

over the pressure or tem-

perature scale on the left 

or right of the plot all pres-

sures or temperatures 

above that point will be 

highlighted with points 

below dimmed and a tem-

porary line drawn.  You 

may also do this with the 

time axis. 

 

 

 

 

You may right click on any area of the plots to see options for adjusting properties of the 

graph such as font sizes, titles, scales, grid lines or text colors. 

Plotting Graphs continued 
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8.3 Zoom 

To zoom in on an area of the plot click the Zoom icon.  Then move the mouse pointer over the 

graph’s central location of the area you would like to zoom in on.  Click and hold the left mouse 

button then move the mouse drawing a temporary box of the zoom area.  Once the zoom 

area has been defined release the left mouse button.  To return to the original plot click the 

Zoom icon again. 

8.4 Adding Arrows 

You may add items such as arrows, text boxes 

and balloons to the plot by clicking on an item in 

the bottom left corner of the window and then 

clicking a beginning and end point of the plot.   

You can remove an added item by clicking delete while the 

item is selected. 

 

 

 

 

 

 

 

 

 

8.5 Printing Graph 

The print button is found in the upper left corner of the graph 

window. 

 

 

 

 

 

 

 

 

8.6 Saving Graph Image to File 

If you do not have a .pdf file writer and would like to save an 

image of the plots to a file use the “Copy to Clipboard” button 

then click the “As a Bitmap” option.   

 

 

 

 

 

 

 

Once this is done then open MS Paint, Excel, Word, or which-

ever program you would like and Paste the image into the 

new file and save it. 
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If you wish to view the previous style of graphs, click either of the two icons near the top of the 

screen for the top or bottom recorder graph.  This will cause a screen to appear with a graph of 

the selected gauge and test.  

9.1 Save as Bitmap   This is the Save As Bitmap button.  It is located in the graphic toolbar at the top 

of the graph.  To save a graph for later viewing, e-mailing or printing, click on the Save As Bitmap 

button.  A submenu will appear, showing the directory which the DTOs were saved to. 

The system will use the file name as a default for the bitmap.  The file name can be changed though, 

to help identify which plot is being saved (i.e. PCP-100-02-24-059-05W4-plot.BMP).  (Also see “To 

Save The Graph as a Bitmap and Print” on Section 8). 

9.2 Zoom In  This is the Zoom In button. It is also located in the graphic toolbar at the top of  

the graph.  To zoom in on the data in the graph, click on the Zoom In button and then click and hold 

the left mouse button on a portion of the graph. Then drag the mouse pointer to the end of the 

section that you wish to view.  When you release the left mouse button, the graph changes to the 

selected section. 

9.3 Zoom Out  This is the Zoom Out button. It is also located in the graphic toolbar at the top 

of the graph.  To zoom out simply click the zoom out button. This will return the graph to its original 

size. 

9.4 Scale Adjustment  This is the Scale Adjustment button.  Also located on the graphic toolbar, it is 

used to adjust the scale on each of the pressure, temperature and time axis.  Click on the Scale 

Adjustment button to activate the submenu box containing the minimum and maximum values 

currently used on the graph.  Tab thru each of the min. and max values for each axis to enter the new 

values for the graph.  Once the adjustments have been entered, click on OK to view the adjusted 

graph.  To return to the original scale, select the box for “Reset to Original Values” and click on OK.  

(Also see “To Change the Axis on a Graph” section on Section 9) 

The data from the graph can also be used to produce a Static Gradient Report. 
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9.0 Plotting Graphs—Previous style continued 
When the data has been downloaded and the graph is plotted in the Panther Software, it can be printed directly 

from the software.  If the operating system does not allow this though, the graph must be saved as a bitmap and 

then printed.  

 

9.5 To Save The Graph As A Bitmap And Print  

Plot graph in software. 

 On the Panther tool bar below the File/Edit/View…. toolbar, select the button on the far right  

 with the camera icon on it. 

 A submenu will appear, asking for a file name and location to save the plot as.  Chose the  directory 

that you want the plot save in and a file name for the plot (the system will allocate   a file name but you 

can change it). 

 Select ‘Save’ when you have chosen the above.  Another submenu will then appear indicating the file 

 and the file path that has been created.  Select OK. 

 Minimize the Panther Software. 

 Open Windows Explorer to enter the directory in which you saved the plot. 

 Select the file name (double click on it).  The Microsoft® Paint screen will appear.  If the screen is not full 

 size, maximize it to view the entire graph.  

 Select the PRINTER icon to print out the graph. 
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9.6 To Print The Graph In The Panther Software 

 On the top toolbar, select File to access the print options. 

 Select Section/Print Set-Up. 

 Change the Print Orientation from Portrait to Landscape. 

 Select OK 

 Select File and then select Print Preview (this allows you to see what will be printed on paper).  If the plot 

 looks correct, select Print.  If it needs to be changed, select Close and adjust your print settings accord

 ingly (i.e. change from Portrait to Landscape). 

 

 Once the plot has been printed, close the bitmap file and return to the Panther Software to continue. 

 

9.7 To Change the Axis on a Graph 

Neither the pressure or the temperature axis can be removed from a graph, as this is part of the software.  It is 

possible, though, to remove or alter the data plotted the graph.  This can be done each time a graph is plotted in 

the Panther Software (the adjustment must be made with each new graph plotted). 

 

 Plot the graph. 

 On the toolbar for the Panther Software, select the button with the up/down arrows on it (the button is 

 right beside the button with the camera icon on it). 

 A sub menu appears on the screen labeled “Top/Bottom Recorder Scale Adjustment”. 
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To Change the Axis on a Graph continued 

 

 To change the range of the axis on the graph, you can change the minimum and maximum values in 

 the temperature, pressure and time fields.  This would assist in magnifying a specific area of a plot, for 

 example, 

 To get a more detailed look at what is happening with one specific value (i.e. pressure). 

 To remove the data being plotted of one specific value, like temperature, enter a 0 for both the 

 minimum and maximum values.  The Temperature axis will remain on the graph, but the data will not 

 be plotted. 

 Once the axis has been changed, select OK if the values are what you want. 

 This plot can now be saved as a bitmap image for printing. 

 

If a mistake is made on resetting the values of the axis: 

 Go back into the “Scale Adjustment”. 

 Select “Reset To Original Values” and click on OK. 

 This will return the graph to its original setup when first plotted. 
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10.0 View Test Data 
To view a tool, click on the View Data button. 

A pop-up will appear.  Select which items you would like to view. 

View Data displays the data using Microsoft® WordPad. 

You can scroll through the data using all the options available in 

WordPad. 

You can search your data, format, save, print, and email directly 

from within the View Data. 

You can also have the Top and Bottom View Data displays open 

at the same time for side-by-side viewing. 

 

Note: You can email directly from WordPad. See WordPad help 

for more information on this option. 
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11.0 Create ASCII File 
To create an ASCII file, click on the ASCII File button for either the Top Recorder or Bottom Recorder. 

 

Select the destination folder from the Save In: 

window and then create a filename for the file.  

Click Save.  A pop-up will appear.  Select which 

items you would like saved.  You will then be 

given the option to view the file saved. 
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12.0 Create CSV File 
To create a CSV (Comma Separated Values) file, click on the CSV File button for either the Top Recorder or Bot-

tom Recorder.  This fie can be opened directly into Microsoft® Excel. 

Select the destination folder from the Save In: 

window and then create a filename for the 

file.  Click Save.  A pop-up will appear.  Select 

which items you would like saved.  You will 

then be given the option to view the file saved. 

 

Note: Microsoft® Excel can not import a CSV 

file that contains more than 65,535 entries.  If 

there is more than this number of samples in 

your CSV file, you will need to filter the sam-

ples down first. 
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13.0 Create Pressure Survey (Report) 
This option is usually used to generate a quick field report of the raw data as well as any additional comments for 

the report.  To create a report, click on the Report button for either the Top Recorder or Bottom Recorder.   

The Pressure Survey dialog box will be displayed prompting you to save the report as a HTML file. 

When Saving Report (HTML): 

The Top Recorder Pressure Survey or Bottom Recorder Pressure Survey dialog box will be displayed. 

 

When Printing Report: 

The print dialog box will be displayed.  

Choose your printer preferences and click 

‘OK’.  You can choose to print all the data or 

compress it to an inputted number of Sec-

tions.  You may also print every nth sample.  

For example, if the recorder is sampling 

every 30 seconds and you only require a 

reading every 15 minutes, you’d choose to 

print every 30th sample (2 samples per min-

ute x 15 minutes).   

Select the destination folder from the Save 

In: window and then create a filename for 

the file.  Click Save.  The file will save as 

an .html file and you can choose to view it in your web browser. 
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14.0 Recorder Specifications 
To display the Recorder Specifications, click on the Specs 1 button for the Top Recorder or the Specs 2 button 

for the Bottom Recorder.   

The Recorder Specifications dialog box will be displayed for the gauge specified. 

 Serial Number: Displays gauge serial number. 

 Range PSI: Displays gauge range (PSI). 

 Calibration Date: Displays the last date the gauge was calibrated (yyyy/mm/dd). 

 Recorder Type: Displays the type of gauge used. 
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15.0 Static Gradient Reports 
After downloading the data from the gauges (as per Section 4), the fields on the main Section of  the software 

can be filled in if the information is available.   If you have downloaded the data earlier though,  and are 

preparing a field report later,  you must retrieve the DT0 files from your computer before starting on the report. 

 

 To open the DTO files, open the 

Panther Software to the main Section, as 

per picture: 

 Click on BROWSE in the Top 

Recorder section. 

A submenu will appear, showing the last 

directory that you were in and the file 

names.   

 Select the DTO file for the top 

recorder and click on OPEN. 

 Repeat this procedure for the 

bottom recorder. 

 Click on GRAPH to view the plot 

of each recorder, or click on VIEW DATA 

to ensure that the correct DTO files have 

been retrieved. 

 

 

 

 

 

 

 

To properly utilize the Gradient Report, ensure that the KB and CF Elevation fields are filled in.  Also ensure that 

the run depths are entered as follows: 

     Top Run Depth (mKB) :        Total Run Depth—Recorder Length       

    (    Example:  1625.8 (run depth) - 0.5 (bottom recorder length) = 1625.3 mKB    )                                    

      Bottom Run Depth (mKB) :  Total Run Depth (As per example, would be 1625.8 mKB) 

Once all available information has been entered into the fields, select Graph to view the plotted data and ensure 

that both sets of data correlate.  To view the raw data, select View Data (as per Section 11).  

Once the raw data has been checked, the stops can be entered in the Graph section of the software and the 

report can be completed,  as discussed on Sections 17 thru 19.             

To save the well and field report information, select File on the main toolbar.  Then select Save As.  A submenu 

will appear, with a default file name.  The default name can be used or it can be changed.  Once the file name is 

complete, click on Okay to save the file to the same directory as the DT0 files. 

 

Note:  THE REPORT PRODUCED IS NOT AN OFFICIAL REPORT. 
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Static Gradient Report Continued (Marking Stops) 
 

In order for this portion of the software to work you must be in the Graph section to mark the stops from the test.  

It is recommended that the graph of the Bottom Recorder is used to select and enter the stops. 

        To mark a stop on the graph, right-mouse click on the graph.                                                                 

        A sub menu will appear, as illustrated.   Select the Add Stop        

        option with a left-mouse click.. 

 
Starting with the first stop on the graph (i.e. the surface stop), move the mouse pointer to about half to two-thirds 

of the way thru the stop. Now left-mouse click on the graph to mark the stop. A green line will appear to act as a 

marker.  You can continue to do this until satisfied with the stop.  The line will change each time you left-mouse 

click.  

When satisfied, right-mouse click again on the graph and select the Save Stop 

option. This saves the stop and places the stop in the Static Gradient Report. 

 

 

 

You will then be prompted to enter some 

information about the stop.  The values to  

enter are length of stop, stop depth and  

incremental depth.  The stop pressure and  

temperature data for the time chosen is 

filled in automatically by the system. (as  

Explained in next section) 
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Static Gradient Report Continued (Marking Stops) 
For the STOP INFORMATION, enter as follows:  

 Time at Stop:  Press on the Arrow Down button and then scroll thru the times to choose the l

 ength of the top (i.e. 5 minutes, 10 minutes, etc.). 

 Stop Depth:  Enter the stop depth (i.e. 0 (at surface), 500, 1000, etc.) 

 Incremental Depth:  If there are several stops that increase by a specific amount (i.e. stop depths 

 are 0, 100, 200, 300, 400, 500, etc), enter in the amount the depths increase (i.e. 100).  This 

 will make the depths increment automatically by this amount on the next stops.  If the depths do 

 not change by the same amount throughout the test, use ‘0’ and enter in each stop depth 

 individually. 

 When all of this information has been entered, click on the OK button to save the stop. 

The Delete Stop option is used to delete the last stop that was added. 

The Delete All Stops option is used to delete all stops that have been added. 

This is the Gradient Report section of the software accessible by clicking on the Gradient Report button on 

the main Section of the software: 

 There are spaces for entering data about tubing and casing pressures.  These can be entered if 

 doing a field gradient report. 

 The grid of data is comprised of the stops that have been selected from the Graph and their 

 corresponding gradient values. 

 Synchronization automatically happens when only one of the gauges has had the stops selected 

 (i.e. the bottom gauge, as recommended at the start of this section), the stops are automatically 

 added to the other gauge. 
 

Possible reports/graphs include:  

      Top Gauge Pressure                     Top Gauge Temperature 

      Bottom Gauge Pressure                Bottom Gauge Temperature 
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15.1 Determining a Fluid Level 
 

The software will calculate fluid levels for the top and bottom gauge pressures.  To calculate a fluid level, right-

mouse click on the graph portion of the Gradient Report screen.  A submenu will appear as follows: 

The Calculate Fluid Level option is used to calculate a fluid level. 

The Delete a Grad Line option is used to delete any lines that are currently 

drawn on the graph.  Fluid levels are not calculated for the temperature 

graphs. 

If you select the Calculate Fluid Level option, you will then be prompted to 

pick from the top or bottom recorder.  It is recommended that the bottom 

recorder is selected, as in some cases, the top recorder may not be in fluid. 

 

Once you have selected a recorder you will then be asked to decide where the fluid level occurs. 

Up to three fluid levels may be chosen, though only one is needed in most tests.  

To choose a fluid level, select the gradient value before the fluid interface. 

In this example, we would select the 

0.191 gradient value, as it is the last 

non-liquid gradient value in the 

sequence  (i.e. the next value of 3.256 

is heavier than gas indicating that the 

gauges are entering fluid). 

 

Common Gradients 

Gas:     0.0  –  2.0 kPa/m 

Oil:       6.0  –  9.0 kPa/m 

Water: 9.7 – 11.5 kPa/m 

 

Once you have finished click on the OK 

button and the fluid levels will be 

calculated and the graph will be 

plotted. 

 

To view the calculated fluid level and MPP Pressure (if applicable): 

 Select the recorder you wish to view. 

 In the File menu on the top tool bar select the Print Preview option. 

 This will display the Static Gradient Report for that recorder as well as the fluid level values. 

 

Note:  Remember to save the gradient report once completed.  In the File menu on the top tool bar, select 

Save As.  Select the directory path in which you want to save the file (if it differs from what the default directory 

is listed), and enter the name of the file (i.e. Gradient04-26-035-05W5).  This will be saved as a text file which 

can be opened and viewed at a later date.  If the report is not saved, all information will be lost pertaining to 

the field report.  Only the DT0/ascii files will remain. 

 

Note: The gradient report produced is only a field report. It is not an official report. 
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16.0 SI Units 
To change the units of measure, make sure that there are no tests currently open. 

The tests can not be minimized so they must be closed. 

On the main Section of the software, in the right hand corner, will be two sets of buttons 

containing the minimize/restore/close buttons.  To close the test section of the 

software, select the CLOSE (X) button in the inner set.   

 

In the View menu on the top toolbar, select the SI Units option. 

The Pick units of measure dialog box will open and from here you can select  

whether to display Metric (kPa), Metric (Bar), Imperial (kPa) units and Absolute 

(pressure minus atmospheric pressure) or Gauge Pressure.  The value for 

Atmospheric Pressure (kPaa) can be changed if necessary in order to display 

Absolute pressure accurately.  The Alberta Canada average for example is 93 

kPaa. 

 

 

 

 

 

 

 

 

 

 

 

17.0 Format Display 
In the View menu on the top toolbar, select 

the Format Display option. 

The Set Display Format dialog box will open 

and from here you can select the display 

format of the delta time, pressure, 

temperature and date for regional settings 

and preferences. 
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18.0 Combine Files 
To combine DTO files, make sure that there are no tests currently open. 

The tests can not be minimized so they must be closed. 

On the main Section of the software, in the right hand corner, will be two sets of buttons 

containing the minimize/restore/close buttons.  To close the test section of the 

software, select the CLOSE (X) button in the inner set.   

In the View menu on the top toolbar, select the Combine Files option. 

The Combine Two Files dialog box will open and from here the user can 

combine two DTO files together to make one file.   

 

 

 

 

 

 

 

First File: Browse directory and 

choose DTO file detailing the first 

part of the test. 

Append File: Browse directory and 

choose DTO file detailing the next 

part of the test. 

 

Shut off time between files:  This 

feature enables the addition of 

time between the two files 

( hh:mm:ss ). 

Battery On Time: Enter the battery 

on time for the new DTO file being 

created. 

Combine: Combines the DTO files identified.  Will prompt for a file name for the DTO file being created.  Progress 

of the combine routine will be monitored with display bar above the Combine button. 

 

Select the destination folder from the Save In: 

window and then create a filename for the file.  

Click Save. 

 

Exit: Closes the dialog box. 
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19.0 Filter DTO File 
To filter a DTO file , make sure that there are no tests currently open. 

On the main Section of the software, in the right hand corner, will be two sets of buttons 

containing the minimize/restore/close buttons.  To close the test section of the 

software, select the CLOSE (X) button in the inner set. 

 

In the View menu on the top toolbar, select the Filter DTO File option. 

The Filter DTO File dialog box will open and from here the user can reduce the size or resolution of a file.  This 

feature can filter by every nth reading , time interval, or the Max. Number of Samples.  The first reading is always 

kept as the starting sample. 

Select DTO File: Browse directory and choose DTO file that will be filtered. 

Choose Sample Filter Type: 

 Every nth: Specify the filter rate to be applied [e.g. Filtering at a rate of ‘2’ results in a every 1st, 3rd, 5th, 

 etc. reading being displayed]. 

 Closest to Time Interval: Specify the time interval the data will be filtered by.  This feature will choose the 

 reading that is closest to the time interval specified. (hh:mm:ss).  i.e. If you entered 15 minutes and had 

 a sample at 00:14:55 (hh:mm:ss) and one at 00:15:10 (hh:mm:ss), the sample at 00:14:55 would be 

 kept as it is the closest. 

 Max Number of Samples: Enter the maximum number of samples you want the data file to contain 

 when filtering is complete.  This is similar to ‘Every nth’ filter type except that ‘Every nth’ is a calculated 

 value to arrive at a specific number of samples. 

Filter: Filters the DTO data file by the number of readings or time interval specified.  Will prompt for a file 

 name for the DTO file being created.  Progress of the filter routine will be monitored with display bar. 

Exit: Closes the dialog box. 

 

Note: Use the ‘Max Number of Samples’ filter type to filter a large data file down to a specific size before 

converting into a CSV file. 
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20.0 Tool Image to File 
On the main Section of the software, in the right hand corner, will be two sets of buttons 

containing the minimize/restore/close buttons.  To close the test section of the 

software, select the CLOSE (X) button in the inner set. 

 

To save an image of a tool, first ensure the gauge is connected to the computer 

through the USB port and communication cable. 

In the View menu on the top toolbar, select the Tool Image to File option. 

A Save Tool Image File as dialog box will appear. 

 

 

 

 

 

Select the destination folder from the Save In: window and then 

create a filename for the file.  Click Save. 

 

 

 

 

 

 

 

 

Download Options 
To revise download options.  In the View 

menu on the top toolbar, select the 

Download Options option. 

A Download Options dialog box will 

appear. 

Select the CSV and/or Ascii Conversion 

Options you desire and click OK.  By 

default the download options will save to 

the location listed (ie. 

“C:\Users\rockdata\” folder).  If you would 

like to change the default location the 

download options will be saved click the 

Select location to save converted files 

button and choose a new Save In folder 

and click OK. 

 

 

 

 

 

www.rockdataservices.com Section 20.0 

http://WWW.rockdataservices.com


21.0 Comments 

 
To input comments into the test data, have 

your test information and DTO files browsed 

into the software. 

In the Edit menu on the top toolbar, select 

the Comments option for the gauge you 

would like to Edit (Top or Bottom…). 

 

The Recorder Comments dialog box will open and from here 

the comments can be added, edited, or deleted in the 

Options menu on the toolbar. 

 

Add: Allows the user to enter comments for a specific Date 

and Time in the pressure survey. 

Edit: Allows the user to edit comments for a specific Date 

and Time in the pressure survey. 

Delete: Allows the user to delete comments for a specific 

Date and Time in the pressure survey. 

 

For  Assistance Call (403) 340-3311    Section 21.0 



22.0 Edit Date/Time 

 
To edit the Date/Time the recorders were ran, have your test information and DTO files browsed into the 

software. 

 

In the Edit menu on the top toolbar, select the Edit Date/Time option and choose either the Top or Bottom 

recorder. 

The Top Recorder Date/Times (MST) or Bottom Recorder Date/Times (MST) dialog box will open and from here 

the Date/Times can be edited (yyyy/mm/dd  hh:mm:ss). 

 

 Battery On Time: Enter the Date/Time the recorder was turned on. 

 On Bottom Time: Enter the Date/Time the recorder was on bottom. 

 Off Bottom Time: Enter the Date/Time the recorder was off bottom. 

  Max. Date/Time: Informs the user of the Battery Off Time given the Battery On Time specified. 
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23.0 Graph Filter Specifications 
 

To filter the graph, have your test information and DTO files browsed into the software. 

 

 

In the View menu on the top toolbar, select the Graph Filter option. 

The Graph Filter Specifications dialog box will open and from here the filter increment can be set.   

 

Filter nth Samples: The number of samples in the data file will be filtered by the specified filter increment. If you 

enter 2—every 2nd sample will be graphed, 3—every 3rd, and so on. 

 

Note: The Graph Filter has no effect on the actual data itself, only what or how much data is displayed. 
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24.0 Problem solving solutions 
24.1 Tool Will Not Connect 

 Check to ensure that the USB dump cable is securely connected to the computer. 

 Check to ensure that the pins on the dump cable and the tool are not bent or dirty.  Bent pins or foreign 

 particles in the connectors will affect how the tool is read.  Often, this will provide enough interference to 

 prevent the tool from being detected by the software. 

 Check to ensure that the USB dump cable is securely connected to the tool.   Carefully line up the notches 

 on the dump cable and the tool, then gently connect  them and turn the wide band around the dump ca

 ble connector until it clicks in place. 

 Check to ensure that the Panther Software has been fully booted up on the computer.  Exit out of the 

 program and then reopen the software.  

Note: All Rock Data Service Tools use a USB cable.   

When the USB cable is correctly installed and connected to the computer it  should be listed as ‘Panther Probe 

Tool’ in the Device Manager.  To check this go to Start\Control Panel\Device Manager and scroll down to the Uni-

versal Serial Bus devices item and click the + sign to expand. 

Note: If your computer has gone into Hibernate or Sleep mode, you may need to disconnect the USB cable and 

reconnect. 

If you are still unable to get the system to read the tool, call Customer Support. 

 

24.2 Battery Life 

One of the most effective ways to ensure that batteries have sufficient life for test is to keep track of the usage on 

each set.   

 Each time a battery is used in a test, mark the length of time that the battery was on for, directly on the 

 battery.  This allows one to monitor the amount of time that the battery was used for. 

 Keep a running record for each battery, listing the length of time that the battery was on for and the sam

 ple rate that was used in the test.  This is a more detailed method of monitoring the battery life, especially 

 when the batteries are used for a variety of tests at varied sample rates. 

It is very important to monitor each battery’s life, especially when running extended tests.  It is best to avoid a bat-

tery  stopping part way through a test.  This will assist with the effort to ensure that the tools run efficiently and 

effectively during all test practices. 

 

24.3 Unable to Print a Graph directly from the Panther Software 

Occasionally, depending on the laptop or the system’s hardware configuration,  a graph can not be printed directly 

from the Panther software.  If there is a conflict in the hardware configuration, or a printer is not available to print a 

plot on, a graph will have to be saved as a bitmap image file.  This allows one to open the file as a bitmap and print 

the plot without causing further conflict.  It also allows one to save a graph to a disk to transport to where it can be 

printed, or e-mailed if necessary.  See “To Save a Graph as a Bitmap Image and Print” in the Print a Graph  section 

on Section 7.2. 
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Problem solving solutions continued 
 

24.4 Locating DT0 Files/Reports On Your Computer 

When saving the data which you are downloading from the gauges, either make note of the directory in which the 

software is saving the files to, or change the directory to a specific directory or drive (i.e. if using a lap top in the 

field, and the data has to be downloaded to a disk so that the gauges can go back in the hole, save the files to 

the floppy drive (i.e. A: drive).  This allows one the flexibility to transfer the data freely from one computer to an-

other, or to e-mail the data if it is needed.)  If you have difficulties changing the directory path to save the data to, 

call Customer Support. 

 

To view the DTO files, click on  BROWSE for either the top or the bottom recorder.  This will bring up the location 

of the last DTO files that you saved.  To view the files, click on either of the files.  If you want to view other DTO 

files, click on the air down key displaying the file directory and then locate the directory or drive which contains 

the files.  Once you have located the files, click on each of them, one under the Top Recorder and the other un-

der the Bottom Recorder.  The files are now loaded into the software, just as they were when they were initially 

dumped from the gauges.   One can view the data, plot a graph, create a static gradient field report and convert 

these files to ASCII format. 
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Problem solving solutions continued 
 

24.5 If the software is unable to locate the DT0 Files which accompany the Field Report 

The software will load in the information for the field report from this file.  It will then ask for the corresponding 

DTO files which accompany the report: 

 

A submenu box titled “Panther Windows Application” will appear stating : 

                        The file “####top.DT0” was not found. 

                         Would you like to look for the file? 

 

Select “Yes” if you would like to load in the data to view the entire field report. 

 

The software will first look in the file directory which the field report file was saved to.  If the DTO files were saved 

to the same directory, select the DTO file which contains the data for the Top Recorder.  If the DTO files have 

been saved to a different directory, you can Look In the computer’s file directories to locate the file you wish to 

view.  Once the DTO file has been located, select the file for the Top Recorder. 

 

A submenu box titled “Panther Windows Application will appear again, as per Step 1.  Select “Yes” to load in the 

second data file for the report.  As with Step 3, ensure that the DTO file selected contains the data for the Bottom 

Recorder. 

 

Once the DTO files have been loaded into the Panther Software, the field report can be viewed.  If gradient stops 

were entered and saved, the stops will appear when the graphs of the gauge data are plotted.  All of the field 

report information will appear just as it was, before the report was saved.    The report can be edited/adjusted 

further if required.   

 

Note: Remember to save the file if any changes have been made to the field report.  If the report is not saved, 

the adjustments will not appear the next time the report is opened.  If you have any difficulties accessing saved 

field reports, call Customer Support for assistance. 
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25.0 NOTES: 

Section 25.0 For  Assistance Call (403) 340-3311    



Rock Data Services Ltd. 

7975 49th Avenue 

Red Deer, Alberta 

T4P 2V5 

Phone: 403-340-3311 

Fax: 403-347-9540 

Email: support@rockdataservices.com 

Website:  www.rockdataservices.com 


